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Notas de versión de Harmony 22.0.4
Harmony 22.0.4, versión 22948 (19-06-2024)

Mejoras

Importar/exportar

Ahora se pueden exportar varios fotogramas al utilizar el comando Export Layout Image (Exportar imagen de 
layout) (File (Archivo) > Export (Exportar) > Layout Image (Imagen de layout)). La nueva opción se llama 
Frames to Export (Fotogramas para exportar) y tiene las siguientes opciones disponibles:

 l Current Frame (Fotograma actual)

 l All Marked Frames (Todos los fotogramas marcados)

 l All Drawing Key Frames (Todos los fotogramas clave de dibujo)

 l All Frames (Todos los fotogramas)

WebCC

El modo de depuración de WebCC ahora se puede habilitar usando la opción -debug desde el símbolo del 
sistema o desde el iniciador de servicio.

Se puede usar el siguiente comando para habilitar todas las trazas de depuración:

node app.js -debug <other args>

Esto equivale a usar:

DEBUG=webcc:* node app.js <args>

Las trazas específicas se pueden habilitar mediante:

node app.js -debug webcc:producer:* <other args>

Esto equivale a usar:

DEBUG=webcc:producer:* node app.js <args>

Secuencias de comandos

 l La clase SyncLayer se ha agregado a la API de secuencia de comandos con las siguientes funciones:

 l syncLayers

 l unsyncLayer

 l La clase ColorOverride se ha ampliado para incluir las siguientes funciones:
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 l setOverrideColorId

 l getOverrideColorId

 l setOverrideColorName

 l getOverrideColorName

 l addSelectedColor

 l removeSelectedColor

 l setSelectedColorID

 l getSelectedColorID

 l setTraverseMatte

 l getTraverseMatte

 l setSelectedColorMode

 l getSelectedColorMode

 l fromXML

 l toXML

 l Las opciones predeterminadas para las funciones de copiar y pegar de Python se han ajustado para 
mayor claridad y facilidad de uso:

 l harmony.CopyOptions(): El intervalo predeterminado es ahora la longitud del fotograma 
actual, en lugar de 0 a 0.

 l harmony.PasteOptions(): El intervalo predeterminado es ahora la longitud del fotograma 
actual, en lugar de 0 a 0.

 l harmony.CopyOptions(): Extendido con un start_frame_src similar y un num_frame_src 
similares a los que usa PasteOptions

 l Clipboard.copy debe proporcionar una superposición de tipo copy (const QStringList 
&nodePaths, const OMC::CopyOptions *copyOptions=null) que utiliza startFrame y numFrames 
de copyOptions.

 l Cuando se proporciona un intervalo como argumentos del método y de copyOptions, los 
argumentos del método lo anulan y tienen prioridad.

 l Si se utiliza un tipo de objeto que no sea CopyOptions o PasteOptions cuando se espera ese 
tipo como argumento, se genera un error.

 l Se ha agregado OpenH264 como códec compatible al usar exporter.exportToQuicktime().

 l Ahora, la ubicación de los paquetes externos de secuencias de comandos se puede establecer 
utilizando la variable de entorno del sistema TB_EXTERNAL_SCRIPT_PACKAGES_FOLDER.
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Linux

Harmony ahora es compatible con CentOS Stream 9. Es posible que sea necesario instalar las siguientes 
librerías en función del tipo de instalación que se haya realizado:

$ sudo dnf install chkconfig SDL xcb-util-keysyms xcb-util-renderutil xcb-
util-image xcb-util-wm jbigkit-libs.x86_64

Correcciones

En esta versión de Harmony y posteriores se han resuelto los siguientes problemas.

General

 l No funciona la acción de pulsar el tabulador para ir de un atributo a otro en la ventana de propiedades 
de un nodo. HAR-9627

 l Desplazarse por la línea de tiempo en macOS con un Magic Mouse o un trackpad hace que la vista salte 
ligeramente. HAR-9283

 l Las capas 2D semitransparentes mezcladas con capas 3D causan problemas de visualización en 
OpenGL. SB-5550

 l Las capas de OpenGL son incorrectas cuando se utiliza una composición 2D con elementos 3D. HAR-
9636

 l La instalación de Harmony no funciona en Windows 11 cuando el control inteligente de aplicaciones 
está habilitado. HAR-9642

 l Cuando se utiliza un archivo shortcuts.conf para especificar la ubicación de la carpeta USA_DB, cambiar 
el conjunto de preferencias seleccionado en las ventanas Preferences (Preferencias) no tiene ningún 
efecto. HAR-9536

 l Harmony puede bloquearse al abrir una vista superior o lateral. HAR-9522

Dibujo

 l Si se anula la selección con la herramienta Select (Seleccionar) manteniendo pulsadas las teclas 
Mayús+Alt, se produce un bloqueo cuando se utiliza sobre pinceladas agrupadas no seleccionadas. 
HAR-9903

 l Hay un pequeño retraso al utilizar las herramientas de dibujo con el ratón. HAR-9999

 l Operación de pegado lenta debido a la gran cantidad de elementos y paletas. HAR-9810

 l Los dibujos pueden contener texturas de lápiz sin usar. HAR-9594

 l Cuando la opción Snap to Contour (Ajustar a contorno) esté habilitada, el editor de contorno agregará 
puntos adicionales al dibujo seleccionado. HAR-9611
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 l Al seleccionar dos veces «Create Color Art from Line Art» (Crear capa de color a partir de una línea), se 
copian las líneas de lápiz en la capa de color. HAR-9553

 l El borrador suave no funciona de manera correcta si se suelta el ratón mientras está fuera de la 
pincelada que se está borrando. HAR-9541

 l El selector de color no selecciona colores de la ubicación correcta del cursor cuando se utilizan varios 
monitores en Linux. HAR-9533

Animación

 l Los papeles cebolla no se muestran de forma correcta si está habilitada la opción «Enable passthrough 
for all effects» (Habilitar paso a través para todos los efectos). HAR-9583

Importar/exportar

 l Los archivos PSD no se pueden importar como capas individuales si Transparency Type (Tipo de 
transparencia) está establecida en Straight (Recto). HAR-9314

 l Los archivos PSB (Photoshop Big) no se pueden importar como capas individuales. HAR-6661

Deformadores

 l La manipulación de los deformadores es muy lenta cuando la cámara de escena no está configurada en 
la cámara predeterminada. HAR-9588

Librería

 l Las secuencias de comandos de escenas no se guardan al crear plantillas en modo de base de datos y 
se configuran usando un archivo shortcuts.conf. HAR-9603

 l Harmony puede bloquearse al pegar en la librería después de deshacer una operación de pegado en la 
vista de nodos. HAR-9475

Renderizado

 l El nodo Scale-Output (Salida de escala) siempre utiliza la configuración de Custom Resolution 
(Resolución personalizada), incluso si se define Resolution Name (Nombre de resolución). HAR-9610

 l El renderizado por lotes puede ser incorrecto e incoherente si se hace referencia a un puerto inexistente 
en el nodo Transformation Gate (Puerta de transformación). HAR-9478

 l La recuperación del color durante el renderizado puede dar lugar a colores incorrectos en los dibujos. 
HAR-9574
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WebCC

 l WebCC no funciona si se exporta un gran número de escenas. HAR-9555

 l Una escena exportada sin conexión a través de WebCC crea una paleta que hace referencia a texturas 
«ficticias». HAR-9505

 l WebCC no puede importar paquetes con un gran número de escenas. HAR-9477

 l Cuando el sistema operativo está configurado en francés o japonés, la ejecución del comando WebCC 
produce un error: TypeError [ERR_INVALID_CHAR]: carácter no válido en el contenido del encabezado. 
HAR-8151

Secuencias de comandos

 l El enlace de Javascript para QByteArray utiliza Latin y no UTF8. HAR-9575

 l Process.execute() no funciona de forma correcta en Windows porque stdout tiene un nombre 
incorrecto. HAR-9539

 l Harmony puede bloquearse al imprimir objetos PySide6 en Python. HAR-9479

 l El intercambio de ilustraciones entre capas de dibujo no funciona mediante secuencias de comandos. 
HAR-9460

Linux

 l La navegación mediante carta de rodaje con atajos de teclado con una configuración de varios 
monitores es más lenta en Harmony 22 que en versiones anteriores de Linux. HAR-9528

 l Harmony se bloquea si la variable de entorno HOME no está definida en Linux. HAR-9623

 l Al mantener presionadas las teclas de flecha para mover un dibujo en la vista de dibujo, este no se 
mueve de forma continua en Linux. HAR-9609

 l Focus on Mouse Enter (Centrarse en ratón) deja de funcionar cada vez que se abre una nueva escena en 
Linux. HAR-9551

 l Algunos dibujos se omiten al navegar por el Drawing Desk (Escritorio de dibujo) utilizando los atajos de 
teclado F y G en Linux. HAR-9550

 l El tamaño de la fuente es demasiado pequeño cuando la visualización de la pantalla está escalada en 
Linux. HAR-9408
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Notas de versión de Harmony 22.0.3
Harmony 22.0.3, versión 21960 (13-09-2023)

Correcciones

En esta versión de Harmony y posteriores se han resuelto los siguientes problemas.

General

 l Al copiar y pegar fotogramas clave de la línea de tiempo, es posible que se pegue un valor incorrecto 
cuando se utilicen funciones de velocidad. HAR-9374

 l El uso repetido de los atajos de teclado para ir al dibujo anterior [F] o al dibujo siguiente [G] puede 
omitir fotogramas en Windows y Linux. HAR-9411

 l Al mantener pulsados los atajos de teclado para ir al fotograma anterior [,] o al fotograma siguiente [.], 
se omiten fotogramas en Linux. HAR-9410

 l Es posible que Harmony no pueda leer dibujos creados hace más de 10 años. HAR-9358

 l Escribir caracteres coreanos de doble consonante no funciona en Windows y Linux. HAR-9080

Línea de tiempo

 l Los marcadores de fotogramas desaparecen al arrastrar y colocar fotogramas en la línea de tiempo. 
HAR-9448

Drawing (Dibujo)

 l Harmony puede bloquearse al utilizar el comando Create Colour Art from Line Art (Crear color a partir 
de línea) en dibujos que tienen triángulos no válidos. HAR-9461

Cámara

 l Se selecciona el color incorrecto cuando se utiliza el selector de color de la vista Colour Picker (Selector 
de color) para seleccionar un color en la pantalla, si hay varias pantallas conectadas y se utiliza un 
factor de escala distinto del 100 %. HAR-9198

Efectos y composición

 l Los efectos Highlight (Resaltar) y Tone (Tono) no se renderizan correctamente cuando las opciones Use 
Matte Colour (Usar color mate) e Invert Matte (Invertir mate) están activadas. HAR-9277

 l Las partículas tienen un tamaño incorrecto cuando el campo de visión de la escena no está configurado 
en vertical. HAR-9325

 l Harmony puede bloquearse al renderizar desenfoques gaussianos si el atributo Repeat Edge Pixels 
(Repetir píxeles de borde) está habilitado. HAR-9304
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 l Todos los botones de opción de la pestaña Enabling (Habilitación) del nodo de escritura tienen la 
misma etiqueta. HAR-9383

Comandos

 l DrawingTools.modifyStrokes de la interfaz de comandos extendida no se puede utilizar para cambiar el 
grosor de un trazo de lápiz. HAR-9269

Importar/exportar

 l No hay audio en las películas exportadas cuando Harmony está en español. HAR-9360

 l Es posible que Harmony se quede sin memoria al renderizar si hay un nodo de efecto Animate Pencil 
Texture (Animar textura de lápiz) en una escena que tiene más de 1200 fotogramas. HAR-9363

 l El efecto Animate Pencil Texture (Animar textura de lápiz) no se aplica aleatoriamente cuando hay dos 
nodos de dibujo o más. HAR-9364

 l El último dibujo expuesto se renderiza en fotogramas vacíos cuando se exporta mediante el comando 
File > Export > OpenGL Frames… (Archivo > Exportar > Fotogramas OpenGL…). HAR-9121

WebCC

 l Una escena exportada antes de actualizar a la versión 22.0.2 no se puede importar mediante WebCC 
después de actualizar la base de datos con el nuevo archivo export.dict. HAR-9367

Centro de control

 l Las paletas se importan al desactivar las opciones Palettes (Paletas) si Scene (Escena) y Backup (Copia 
de seguridad) no están desactivadas también. HAR-5105

Problemas conocidos
 l Cuando no hay suficiente espacio para mostrar todos los botones de una barra de herramientas, la 

extensión que se abre para acceder a los botones se ocultará en las vistas que utilizan OpenGL. HAR-
8186

 l Cuando se utiliza Harmony en macOS Big Sur, Harmony se puede bloquear al guardar un color en el 
selector de color nativo de macOS. HAR-8032

 l Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del 
Centro de control. HAR-6386

 l El trazo permanece en su lugar después de eliminar el último punto de una rama con la herramienta 
Centerline Editor (Editor de línea central). HAR-5994

 l Cuando se utiliza un iPad Pro en modo Sidecar con Harmony, cada segundo clic se registra como un 
doble clic. HAR-8801

 l Actualizar el sistema operativo a macOS Ventura puede ayudar a solucionar este problema.
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 l En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de 
cuarentena del paquete de aplicaciones. HAR-7775

El atributo extendido de cuarentena se puede eliminar mediante el siguiente comando en el terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 
Premium"
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Notas de versión de Harmony 22.0.2
Harmony 22.0.2, versión 21617 (12-06-2023)

Mejoras

Utilidades

 l La utilidad utransform ya puede imprimir y eliminar los metadatos de un archivo TVG con las opciones -
print_meta_data y -clear_meta_data. HAR-8421

Secuencia de comandos

 l La descripción de la versión de la escena ya se puede consultar y configurar con scene.Description y 
scene.setDescription desde la interfaz de secuencias de comandos de Harmony. La descripción también 
se puede configurar al importar una escena desde el Centro de control con ImportData.impDescription. 
El texto de la descripción tiene un límite de 200 caracteres UTF-8. HAR-8792

 l La función JavaScript scene.closeSceneAndOpen tiene un nuevo parámetro, isReadOnly, que permite 
abrir una escena en modo de solo lectura. Por ejemplo, al usar scene.closeSceneAndOpen( "Env", "Job", 
"Scene01", "1", true), se cerrará la escena actual y se abrirá Scene01 (Escena01) en modo de solo 
lectura. Solo se puede usar cuando se abre una escena en Harmony desde la base de datos. HAR-9042

 l Se ha agregado la función de secuencia de comandos 
SceneOffline.createDatabasePartialUpdatePackage para crear paquetes de actualización parcial para 
cargarlos en WebCC. HAR-8875

 l El comando TB_MayaBatchRenderModule.js se ha modificado para admitir renders utilizando el plugin 
de renderizado 3Delight para Maya. HAR-9148

Correcciones

En esta versión de Harmony y posteriores se han resuelto los siguientes problemas.

Cámara

 l Los pequeños cambios en el FOV de la cámara no tienen ningún efecto y provocan interrupciones de 
flujo al animar el FOV. HAR-9005

 l El atajo de la tecla Tab para mover el pivote de la herramienta Transform (Transformar) no funciona. 
HAR-8868

Herramientas y flujo de trabajo de dibujo

 l Harmony se bloquea al cerrar una forma dibujada con un lápiz de texturas al mantener pulsada la tecla 
Ctrl (tecla Comando en macOS) mientras Mirror View (Vista de espejo) está habilitada. HAR-9011
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 l Al dibujar con la herramienta Ellipse (Elipse) o Rectangle (Rectángulo) con ajuste, se puede dibujar en 
la capa de dibujo incorrecta. HAR-8985

 l Harmony puede bloquearse al rotar un dibujo con Ctrl+7 (tecla Comando+7 en macOS) mientras la 
herramienta Select (Seleccionar) está activa. HAR-9118

 l Bloqueo en raras ocasiones al usar la herramienta Stroke (Trazo). HAR-9123

 l Bloqueos aleatorios en la herramienta Pencil Editor (Editor de lápices). HAR-9126

 l El Contour Editor (Editor de contornos) crea bucles al ajustar vértices adyacentes. HAR-9131

 l Las líneas de las capas no seleccionadas son difíciles de ver cuando Light Table (Mesa de luz) está 
habilitada y el espacio de color para trabajar está establecido en Linear (Lineal). HAR-7446

 l Un objeto de dibujo cortado no se pegará en la ubicación adecuada si hay un desplazamiento en la capa 
de dibujo de origen o destino. HAR-8854, HAR-9168

 l [Windows] Las miniaturas de Drawing Desk (Escritorio de dibujo) se muestran en baja resolución en 
monitores HiDPI. HAR-8885

 l La vista de dibujo a veces no se actualiza al cambiar el dibujo seleccionado en la vista de dibujo del 
escritorio mediante los atajos de teclado F y G. HAR-9073

 l La preferencia «Light Table: Shade in Camera View» (Mesa de luz: Sombrear en vista de cámara) no se 
está guardando. HAR-9075

 l Los dibujos de la vista de referencia no se actualizan cuando se cambian los colores con Colour Picker 
(Selector de color). HAR-9076

 l [Linux] La herramienta de cuentagotas de Colour Picker (Selector de color) siempre selecciona los 
valores RGB 0, 48, 57. HAR-8778

 l Los atajos de teclado de zoom y rotación se pueden usar mientras se dibuja. HAR-9077

 l El atajo para cambiar a la herramienta Select (Seleccionar) no funciona en la vista de referencia. HAR-
9094

 l Drawing View Magnifier (Lupa de la vista de dibujo) no funciona correctamente. HAR-9018

 l Al eliminar un dibujo en la vista de sustitución de dibujos, que también está vinculada en una columna 
de tiempo de carta de rodaje, se puede provocar un bloqueo. HAR-9224

 l Si se habilita Adjust Pencil Line Thickness (Ajustar grosor de líneas del lápiz) en Drawing Layer 
Properties (Propiedades de capa de dibujo), es posible que se produzcan artefactos en las líneas del 
lápiz al renderizar. HAR-9250

 l Al aumentar las divisiones de ancho y altura en la herramienta Envelope (Envolvente), se puede 
provocar un bloqueo. HAR-9264

 l Los elementos y dibujos se duplican al cortar y pegar nodos de elementos en la vista de nodos. HAR-
9078
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Editor de funciones

 l La selección de varios puntos en una ruta 3D en Function editor (Editor de funciones) con la herramienta 
de selección de recuadro no funciona. HAR-9103

 l Function editor (Editor de funciones) confirma un valor aleatorio en el fotograma clave seleccionado 
cuando el campo Value (Valor) esté vacío y pierda el enfoque. HAR-8830

General

 l Al deshacer después de vincular y reordenar paletas se puede provocar un bloqueo. HAR-7725

 l Los dibujos duplicados se pueden perder al guardar una escena si las capas sincronizadas tienen el 
mismo nombre base. HAR-8887

 l Si se copian varias capas sincronizadas desde una instancia de un personaje a otra, los dibujos nuevos 
pueden perderse. HAR-8899

 l El cuadro delimitador de la herramienta Transform (Transformar) está en la posición incorrecta cuando 
se utilizan dibujos de mapa de bits con deformadores ponderados o de forma libre. HAR-7787

 l Harmony se congela al intentar leer un archivo TVG que contiene metadatos. HAR-8409

Importar/exportar

 l Los archivos PSD guardados en Photoshop con el modo de compatibilidad deshabilitado no se 
importan correctamente cuando se utiliza opción Single Layer (Una sola capa única). HAR-8849

 l Al importar una imagen de layout PSD junto con su archivo XLI, se utiliza el archivo XLI de una imagen 
importada anteriormente. HAR-9175

 l Harmony se bloquea al renderizar a imágenes SGI en escala de grises de 8 bits. HAR-9010

 l Al cambiar de nombre a una paleta, la lista de paletas no se marca como modificada, lo que hace que la 
paleta no se guarde. HAR-9179

 l El nodo Multi Layer Write (Escritura multicapa) puede hacer que las sustituciones de dibujo adyacentes 
se compongan en el mismo fotograma al exportar mediante Render Write Nodes (Renderizar nodos de 
escritura). HAR-8228

Nodos y composición

 l El nodo OGL-Controller (Controlador OGL) renderiza con suavidad el dibujo del cable que está 
conectado al puerto Controller Position (Posición del controlador). HAR-8877

 l El nodo Deformation Composite (Composición de deformación) bloquea la transformación desde los 
peg ascendentes. HAR-9034

 l Harmony se bloquea cuando OGL-Controller (Controlador OGL) tiene una etiqueta y la escala del peg 
conectada está establecida en 0. HAR-9102
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 l El nodo Matte-Resize (Cambio de tamaño de mate) puede provocar un error de renderizado. HAR-9163

 l El efecto Blur (Desenfoque) en los dibujos conectados a un nodo Highlight (Resaltar) o Tone (Tono) no 
se procesa correctamente en la intersección con el borde de la cámara si la opción Invert Matte (Invertir 
mate) está habilitada. HAR-9181

 l El nodo Auto-Patch (Parche automático) puede provocar un bloqueo al renderizar y cambiar fotogramas 
si se muestran miniaturas en la vista de nodos. HAR-9255

Rendimiento

 l Arrastrar y soltar fotogramas en la línea de tiempo puede ralentizarse con algunas escenas. HAR-8726

 l Las operaciones que implican cambiar el fotograma actual se vuelven más lentas con más controles de 
Master Controller (Controlador maestro) visibles. HAR-8747

Integración de renderizado y pipeline

 l Harmony se puede bloquear debido a daños en la memoria al renderizar una escena por lotes si se 
utiliza un gran número de subprocesos de renderizado. HAR-7875

 l A veces se pierden dibujos pequeños o sencillos de fotogramas renderizados al renderizarlos utilizando 
varios subprocesos en procesadores rápidos. HAR-9012

 l Los softwares de terceros detectan el canal alfa de las películas renderizadas con ProRes 4444 o 4444 
XQ como recto. HAR-7363

 l [Windows] El renderizado en ProRes en Windows redondea la resolución horizontal al múltiplo de 16 
píxeles más cercano y recorta las imágenes renderizadas. HAR-9001

 l La exportación a SGI en 16 bits provoca bloqueos o daños en el color. HAR-9008

 l Harmony puede bloquearse al renderizar por lotes si las paletas se encuentran fuera de la escena. 
HAR-9023

 l Colores incorrectos cuando la profundidad de procesamiento de la escena es de 32 bits y el formato de 
exportación está establecido en 8 bits. HAR-9047

 l Harmony puede bloquearse al mostrar modelos 3D en la vista de perspectiva si la preferencia de 
OpenGL «Enable composite passthrough for all effects» (Habilitar atravesar composiciones para todos 
los efectos) está habilitada. HAR-9082

 l El nodo Hold-Timing (Tiempo de hold) provoca problemas de actualización de OpenGL y un posible 
bloqueo. HAR-9161

 l La selección con la tecla Mayús no funciona bien al desplazarse por la lista de trabajos de la cola de 
renderizado. HAR-9117

 l Las películas exportadas con 23,976 fotogramas por segundo tienen los fotogramas por segundo 
expresados como 2997/125 en lugar de 24000/1001. HAR-9109

14



 l Cuando se produzca un error al sobrescribir un archivo de película existente porque se abra o bloquee 
durante el renderizado por lotes, Harmony escribirá la película con un nombre único utilizando la fecha 
y la hora. HAR-9133

Secuencia de comandos

 l addNodeToSelectionNode, addNodesToSelectionNode y removeNodeFromSelection en la clase de 
selección no funcionan correctamente con telones de fondo. HAR-8391

 l La librería de multiprocesamiento de Python está mal configurada cuando se ejecuta en Windows. 
HAR-8567

 l TB_RecolorDrawing.js no funcionará si un nodo de dibujo seleccionado no tiene un ID de elemento. 
HAR-9062

Línea de tiempo y reproducción

 l La reproducción se detiene momentáneamente al final cuando las opciones Loop (Bucle) y Sound 
(Sonido) están habilitadas. HAR-8988

 l El atajo de teclado F para «Go to Previous Drawing» (Ir al dibujo anterior) omite las exposiciones de 
teclas. HAR-9019

 l Cuando la preferencia «Snap Keyframe» (Ajustar fotograma clave) está habilitada, copiar y pegar un 
fotograma clave en la línea de tiempo puede provocar un bloqueo. HAR-9199

Interfaz de usuario

 l No es posible usar la tecla de retroceso para eliminar el último dígito en algunos campos, como los del 
cuadro de diálogo «Render Write Node» (Renderizar nodos de escritura). HAR-9009

 l Escribir valores decimales en campos de entrada numéricos no funciona cuando el sistema operativo 
está configurado en francés. HAR-9016

 l [Windows] Reproducir no funciona cuando hay una vista Camera (Cámara) contraída en la zona de 
trabajo. HAR-9141

 l [Windows] Expandir una vista de cámara oculta puede provocar un bloqueo si un monitor HiDPI tiene 
habilitada la escala. HAR-9142

 l [Linux] Focus On Mouse Enter (Centrarse en ratón) no siempre funciona. HAR-9095

 l Los caracteres coreanos no se escriben correctamente. HAR-9080

 l Harmony se bloquea si aparece la advertencia Auto-Save (Guardar automáticamente) al realizar una 
operación de arrastrar y colocar. HAR-9235
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Base de datos/Centro de control

 l Copiar una escena en el Centro de control no funciona si la escena no está seleccionada una vez que se 
abre el cuadro de diálogo Copy Scene (Copiar escena). HAR-7888

 l [WebCC] Los mensajes de notificación del sistema ya no aparecen una vez terminadas las 
importaciones y exportaciones. HAR-8884

 l WebCC deja de responder a las solicitudes de base de datos si está inactivo durante 48 horas. HAR-
9114

 l El ensamble de muchas escenas en WebCC genera un error [Error: EMFILE: too many open files... (Error: 
EMFILE: demasiados archivos abiertos)]. HAR-9122

 l El Centro de control no guarda la configuración «Get rights to modify all assets» (Obtener derechos 
para modificar todos los activos) para los entornos. HAR-9074

 l Cuando «Update Database Scene» (Actualizar escena de base de datos) falla, el informe de errores es 
poco informativo y a veces incorrecto. HAR-8843

 l Se puede bloquear la carpeta raíz, pero esto impide el bloqueo de cualquier otra carpeta de la base de 
datos. HAR-8556

 l El renderizado desde la interfaz de comandos del Centro de control no utiliza la cámara predeterminada 
de la escena a menos que se especifique por nombre. HAR-8403

 l [Windows] WebCC no se inicia en una nueva instalación de Windows porque MSVCR120.dll no se 
encuentra en la ruta. HAR-8873

 l Con el comando «Update Database Scene» (Actualizar escena de base de datos), se puede dañar la 
escena en la base de datos si esta se modificó después de exportarla sin conexión. Para resolver este 
problema, se ha añadido a Harmony 21.0.4 un nuevo archivo de diccionario llamado export.dict. El 
archivo export.dict se deberá copiar de forma manual en la carpeta /USA_DB/dicts/ de las bases de 
datos de Harmony existentes. Las bases de datos nuevas creadas con Harmony 21.0.4 tendrán el 
nuevo archivo de diccionario. HAR-8858

Carta de rodaje

 l Cuando el teclado está establecido en francés, al presionar la tecla ^ en Carta de rodaje se bloquea 
Harmony. HAR-9006

 l Bloqueos aleatorios y en raras ocasiones en la interfaz de usuario de Carta de rodaje. HAR-9125

Problemas conocidos
 l Cuando no hay suficiente espacio para mostrar todos los botones de una barra de herramientas, la 

extensión que se abre para acceder a los botones se ocultará en las vistas que utilizan OpenGL. HAR-
8186
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 l Cuando se utiliza Harmony en macOS Big Sur, Harmony se puede bloquear al guardar un color en el 
selector de color nativo de macOS. HAR-8032

 l Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del 
Centro de control. HAR-6386

 l El trazo permanece en su lugar después de eliminar el último punto de una rama con la herramienta 
Centerline Editor (Editor de línea central). HAR-5994

 l Cuando se utiliza un iPad Pro en modo Sidecar con Harmony, cada segundo clic se registra como un 
doble clic. HAR-8801

 l Actualizar el sistema operativo a macOS Ventura puede ayudar a solucionar este problema.

 l En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de 
cuarentena del paquete de aplicaciones. HAR-7775

El atributo extendido de cuarentena se puede eliminar mediante el siguiente comando en el terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 
Premium"
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Notas de versión de Harmony 22.0.1
Harmony 22.0.1 versión 22.0.1.19338 (2023-03-01)

Correcciones

En esta versión de Harmony y posteriores se han resuelto los siguientes problemas.

Herramientas de dibujo

 l El uso de la herramienta Close Gap (Cerrar hueco) al dibujar con una tableta puede provocar un 
bloqueo. HAR-8828

 l La opción Paste Drawing Object in Place (Pegar objeto de dibujo en su lugar) no funciona cuando el 
foco está en la línea de tiempo o en la carta de rodaje. HAR-8606

Herramientas de animación

 l La herramienta Shift and Trace (Desplazar y trazar) no muestra el dibujo mientras se cambia de 
posición. HAR-8458

 l Los agujeros de peg y los cabellos cruzados del dibujo anterior desaparecen después de mover el 
dibujo con la herramienta Shift and Trace (Desplazar y trazar). HAR-8038

Línea de tiempo y reproducción

 l Create Cycle (Crear ciclo) desordena el tiempo de la capa y no se puede deshacer. HAR-3867

 l Los marcadores de fotograma no se invierten cuando se utiliza el comando Paste Reverse (Pegar 
inverso). HAR-7385

 l Una capa establecida en el modo de contorno en la línea de tiempo siempre se muestra en negro en la 
vista de cámara. HAR-8573

 l [Windows] La reproducción puede atascarse cuando se estén habilitados Loop (Bucle) y Sound 
(Sonido). HAR-8808

Efectos

 l Un dibujo vectorial conectado a un nodo Planer Region (Plano-región) que está definido para utilizar 
dibujo vectorial conectado a un emisor de sprite puede provocar un bloqueo. HAR-8763

 l Ciertos efectos de sombreado pueden mostrar resultados no uniformes entre renderizado de 16 bits y 
de 32 bits. HAR-8721

 l El efecto de brillo produce artefactos cuando los atributos de alfa no están establecidos en los valores 
predeterminados y la escena está configurada para renderizar en 32 bits. HAR-8752

 l El efecto bokeh causa reflejos cuando hay un movimiento lento de la cámara. HAR-8803
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 l Los efectos de bokeh y desenfoque renderizan con artefactos cuando está habilitada la opción Enable 
Graphic Card Acceleration (Habilitar aceleración de tarjeta gráfica) en las preferencias. HAR-8802

Cámara

 l La opción Show Snapshot (Mostrar instantánea) en la vista de cámara no muestra correctamente 
ciertos efectos. HAR-8735

 l El límite del plano de recorte alejado de la cámara no se puede elevar por encima de las 1000 unidades. 
HAR-8805

3D

 l Los modelos 3D y las capas 2D desaparecen al rotar la vista en perspectiva 90 grados. HAR-8758

Deformadores

 l Los círculos de distancia mínima y máxima mostrados para los deformadores ponderados no tienen el 
tamaño adecuado en las pantallas Retina/HiDPI. HAR-8610

 l Los círculos de distancia mínima y máxima mostrados para los deformadores ponderados no se escalan 
con el dibujo. HAR-8609

 l El uso de la herramienta Transform (Transformar) con Control Selection Mode (Modo de selección de 
control) habilitado no funciona en una cadena de deformación recién creada. HAR-4650

Nodos y vista de nodo

 l Bloqueo al introducir texto en el campo de búsqueda de la vista de nodos. HAR-8850

 l Un nodo Channel Swap (Intercambio de canal) conectado directamente a una pantalla no renderiza 
correctamente. HAR-8728

 l Bloqueo después de habilitar Publish Attribute Mode (Modo de publicación de atributos) y el atributo 
Drawing (Dibujo) en el nodo Transformation Switch (Conmutador de transformación). HAR-8848

 l Las opciones Timing Columns (Columnas de tiempo) en el nodo Transformation Switch (Conmutador 
de transformación) no funcionan correctamente. HAR-7796

 l El renderizado es incorrecto cuando un nodo selector de capa de dibujo se establece como aplanado y 
se utiliza en combinación con el nodo Animate Pencil Texture (Textura de lápiz de animación). HAR-
8809

 l La reducción del canal alfa mediante un nodo Matte-Resize (Cambio de tamaño de mate) no funciona si 
la imagen de origen no tiene suavizado de contorno. HAR-8582

Importar/exportar

 l La importación de imágenes desde el escáner se bloquea después de obtener una vista previa de las 
imágenes. HAR-8818
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 l Los archivos PSD de Adobe Photoshop 2021 y posteriores están vacíos en Harmony. HAR-8819

 l Las imágenes y los modelos 3D desaparecen de la escena si el nombre del archivo termina con una v y 
tres dígitos (-v001). HAR-7118

 l [Windows] El pegado de una imagen copiada de un navegador web no funciona. HAR-8796

 l Pérdida de precisión y bandas de color al escribir imágenes de 8 bits en JPG, TGA, TIF y SGI si hay una 
conversión del espacio de color. HAR-8826

Secuencias de comandos

 l La API de Python de Toon Boom no puede cargarse a menos que se disponga de una licencia con base 
de datos. HAR-8832

 l Agregar la documentación de la interfaz de Python al menú Help (Ayuda). HAR-8769

 l Un dibujo creado mediante un comando de Python no está marcado como existente en el sistema de 
archivos, y no se puede cargar y renderizar inmediatamente. HAR-8856

 l El comando TB_ExportCamera invierte la cámara cuando algunos ejes se giran 180 grados. HAR-8647

 l [Linux] Los paquetes de complementos/secuencias de comandos no se cargan al inicio. HAR-8812

 l TB_GameExportWindow.js no está empaquetado en Harmony 22. HAR-8811

 l Agregar un método de comandos, setNumberOf a SCR_FrameInterface, que establece la duración de 
escena (mueve el controlador rojo final) sin borrar el dibujo ni el fotograma clave. HAR-7358

 l Harmony se bloquea al renderizar un modelo 3D a través de la interfaz de secuencias de comandos de 
Python. HAR-8750

Rendimiento

 l [macOS] Harmony se bloquea a veces al reactivarse desde el modo de suspensión. HAR-8359

 l [macOS] Cuando se ejecuta en japonés, el asistente de licencias puede bloquearse al instalar el servicio 
de licencias. HAR-8694

 l La preferencia Save Scene Automatically (Guardar escena automáticamente) no funciona 
correctamente cuando Harmony se deja en reposo. HAR-6564

 l Las vistas superior y lateral tardan mucho tiempo en actualizarse mientras se renderizan las miniaturas. 
HAR-8760

Dispositivos

 l [Windows] Los gestos táctiles de la tableta Wacom para hacer zoom, panear y rotar no funcionan. 
HAR-8739
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Interfaz de usuario

 l [Windows] Al cambiar el tamaño de la ventana Preferences (Preferencias), esta puede desaparecer de 
la pantalla si la escala de visualización no es del 100 %. HAR-8566

Base de datos/Centro de control

 l El informe de errores de Update Database Scene (Actualizar escena de base de datos) es poco 
informativo y a veces incorrecto. HAR-8843

 l La información sobre el bloqueo de escenas no se muestra correctamente en el Centro de control. HAR-
8049

 l [macOS] Después de cerrar una escena en el modo de base de datos, Open (Abrir), Palette Operations 
(Operaciones de paleta) y otros comandos pueden dejar de responder. HAR-8766

Integración de renderizado y pipeline

 l Las paletas y las listas de paletas están potencialmente bloqueadas durante el renderizado por lotes 
normal. HAR-8667

 l Harmony no funciona con el sistema de archivos de NAS en la nube LucidLink en macOS. HAR-8806

 l Las estaciones de trabajo que no tienen una GPU pueden no tener instaladas las librerías OpenCL y 
fallarán al cargar los complementos para los efectos OpenCL, como el desenfoque. HAR-8693

 l Harmony se encuentra en estado "Not Responding" (No responde) durante mucho tiempo antes de 
generar y cargar una vista previa de instantánea desde Producer. HAR-8817

 l Las dependencias tbprocess/cola entre trabajos de renderizado no son correctas. HAR-8816

Otros

 l Borrar una columna en la carta de rodaje y luego deshacerla puede provocar un bloqueo. HAR-8795

 l El editor de metadatos no aplica correctamente los valores de los metadatos de escena. HAR-8748

Problemas conocidos
 l Cuando no hay suficiente espacio para mostrar todos los botones de una barra de herramientas, la 

extensión que se abre para acceder a los botones se ocultará en las vistas que utilizan OpenGL. HAR-
8186

 l Cuando se utiliza Harmony en macOS Big Sur, Harmony se puede bloquear al guardar un color en el 
selector de color nativo de macOS. HAR-8032

 l Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del 
Centro de control. HAR-6386

 l El trazo permanece en su lugar después de eliminar el último punto de una rama con la herramienta 
Centerline Editor (Editor de línea central). HAR-5994
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 l Cuando se utiliza un iPad Pro en modo Sidecar con Harmony, cada segundo clic se registra como un 
doble clic. HAR-8801

 l Actualizar el sistema operativo a macOS Ventura puede ayudar a solucionar este problema.

 l En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de 
cuarentena del paquete de aplicaciones. HAR-7775

El atributo extendido de cuarentena se puede eliminar mediante el siguiente comando en el terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 
Premium"
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Notas de versión de Harmony 22
Esta es la lista de cambios en Harmony 22; versión 22.0.0.18839 (26-09-2022):

Nuevas funciones

Flujo de trabajo de dibujo

Característica Descripción

Se ha actualizado la vista de 
modelo, que ahora se denomina 
vista de referencia

La vista de referencia (antes conocida como vista de modelo) ahora se puede 
utilizar para importar y mostrar imágenes de mapa de bits que se pueden 
utilizar como inspiración o como referencias mientras se dibuja.

Las imágenes importadas se guardan automáticamente en la carpeta de 
modelos de la escena. A continuación, estas imágenes de referencia se pueden 
cargar bajo demanda en sesiones posteriores mediante el comando Load 
Default References (Cargar referencias predeterminadas).

Se ha agregado a la vista el nuevo comando Delete Current (Borrar actual) 
para poder borrar las imágenes de la carpeta de modelos de la escena sin tener 
que borrarlas manualmente mediante el explorador de archivos.

Ahora puede importar imágenes y dibujos a la vista de referencia arrastrando y 
soltando desde un explorador de archivos o pegando imágenes desde el 
portapapeles.

Previsualización en vivo al 
dibujar con textura de lápiz

Ahora, la herramienta Pencil (Lápiz) muestra la textura del lápiz, así como el 
patrón de grosor asignado al valor predefinido del lápiz seleccionado mientras 
se dibuja la línea, lo que proporciona una previsualización en vivo y precisa de 
la línea final.

Pegar en el lugar

Un nuevo comando denominado Paste Drawing Object in Place (Pegar objeto 
de dibujo en el lugar) ya está disponible en el menú Edit (Edición). A diferencia 
del comando Paste Drawing Object (Pegar objeto de dibujo), que pega un 
objeto de dibujo copiado con un ligero desplazamiento, el nuevo comando 
Paste Drawing Object in Place (Pegar objeto de dibujo en el lugar) siempre 
pega el objeto de dibujo copiado en la misma posición que el original. Se puede 
acceder al nuevo comando desde el menú Edit (Edición), y tiene asignado el 
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Característica Descripción

atajo de teclado Ctrl+Mayús+V (Command+Mayús+V en macOS).

Acceso directo Frame Drawing 
Selection (Selección de 
fotograma)

Se ha agregado a Harmony un nuevo comando de acceso directo denominado 
Frame Drawing Selection (Selección de fotograma). Al utilizar este comando 
cuando una herramienta de dibujo está activa, se centrará la vista de cámara o 
de dibujo en el dibujo seleccionado. El atajo de teclado predeterminado para 
este comando es Mayús+F.

Renderizado

Característica Descripción

Procesamiento de renderizado 
de 32 bits por canal

Ahora, las operaciones de renderizado internas en Harmony pueden realizarse 
utilizando valores de punto flotante de 32 bits por canal. Esto proporciona más 
precisión y aumenta la compatibilidad con valores de color por debajo de 0 y 
por encima de 1 para el renderizado de alto rango dinámico y precisión del 
color.

La profundidad de bits que se utiliza para el procesamiento interno se puede 
cambiar entre 16 bits o 32 bits por canal en la pestaña Colour Space (Espacio 
de color) de la ventana Scene Settings (Configuración de escena).

Cuando se seleccionan 16 bits por canal, las escenas se renderizan como en las 
versiones anteriores de Harmony. Cuando se selecciona 32 bits por canal 
(flotante), todas las operaciones de procesamiento interno se realizan con una 
precisión de punto flotante de 32 bits y no se recortan los valores de color a 1. 
Esto permite a Harmony conservar los valores de color incluso cuando un 
efecto eleva los valores de los colores más allá del blanco, lo que permite que 
los efectos posteriores recuperen esos colores al bajar los valores.

Las nuevas escenas creadas en Harmony 22 están configuradas para utilizar el 
procesamiento de renderizado de 32 bits por canal de forma predeterminada. 
Las escenas de las versiones anteriores se ajustan a 16 bits por canal para que 
sean compatibles con las versiones anteriores.

Compatibilidad con imágenes Las imágenes EXR guardadas con una profundidad de color de punto flotante 
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Característica Descripción

EXR de punto flotante de 32 
bits

de 32 bits que contengan valores superiores a 1 ahora se pueden leer y sus 
valores se conservan durante todo el proceso de renderizado.  

Harmony ahora también tiene la capacidad de escribir imágenes EXR con una 
profundidad de color de punto flotante de 32 bits.

Visualización de los valores de 
color

En la barra de estado de la vista de cámara ahora se muestran los valores de 
color del píxel que está bajo el ratón cuando la vista de cámara está en Render 
View Mode (Modo de vista de render). Los valores se expresan como números 
enteros entre 0 y 32767 cuando la escena está configurada para renderizar en 
16 bits por canal y como valores de punto flotante cuando la escena está 
configurada para renderizar en 32 bits por canal.

Efectos y composición

Característica Descripción

Desenfoque de Bokeh

El efecto Bokeh Blur (Desenfoque de Bokeh) en Harmony simula el modo en 
que el objetivo de una cámara desenfoca los elementos en función de la forma 
de su iris.

Para simular la profundidad de campo, se puede utilizar un mate alfa con este 
efecto para controlar la cantidad de desenfoque aplicada a las distintas áreas 
de la imagen. Las áreas opacas en el mate alfa aplicarán el efecto por completo 
mientras que las áreas transparentes en el mate alfa no aplicarán el efecto. El 
nodo Bokeh Blur (Desenfoque de Bokeh) está disponible en la librería de 
nodos en Filter > Blur (Filtro > Desenfoque).
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Característica Descripción

Para obtener más información, consulte Nodo Bokeh-Blur (Desenfoque de 
Bokeh).

Efecto Animar textura de lápiz

El nuevo nodo de efecto Animate Pencil Texture (Animar textura de lápiz) 
funciona de forma similar al nodo Shake (Vibración), pero en lugar de que 
vibren los dibujos o la cámara en la escena, aplica transformaciones aleatorias 
a las texturas de las líneas de lápiz. Se puede utilizar para dar vida a los dibujos 
simulando las líneas de ebullición que se producen en las animaciones 
dibujadas a mano, en las que se dibuja una nueva línea en cada fotograma. 

El nodo Animate Pencil Texture (Animar textura de lápiz) puede detectar 
automáticamente cuando hay una transformación o un cambio de dibujo y 
aplicar el efecto a la textura. No es necesario cronometrar el efecto ni mantener 
la duración manualmente. 

 

El nodo Animate Pencil Texture (Animar textura de lápiz) está disponible en la 
categoría Filter (Filtro) de la librería de nodos.

Modos de mezcla mejorados

Los modos de mezcla disponibles en los nodos Blending (Mezcla) y 
Composite-Generic (Composición genérica) se han actualizado para que sean 
compatibles con el renderizado en escenas configuradas para utilizar el 
procesamiento de 32 bits por canal, así como para proporcionar resultados más 
cercanos a los modos de mezcla de aplicaciones de terceros. 

Se ha simplificado la lista de modos de mezcla para eliminar los modos de 
mezcla beta y anteriores. Sin embargo, para que sean compatibles con 
versiones anteriores, los nodos Blending (Mezcla) y Composite-Generic 
(Composición genérica) en escenas de versiones anteriores de Harmony 
tendrán la lista completa de modos de mezcla anteriores y beta. Las nuevas 
instancias de estos nodos solo mostrarán la lista actualizada.  

Algunos modos de mezcla requieren valores fijos superiores a 1 para poder 
ofrecer el mismo resultado que los software de terceros. Sin embargo, los 
valores fijos limitan el uso de los modos de mezcla en el contexto de un 
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Característica Descripción

pipeline de HDR. Se ha introducido el nuevo atributo Clamping Mode (Modo de 
fijación) en los nodos Blending (Mezcla) y Composite-Generic (Composición 
genérica) para controlar si los valores se deben fijar o no.

Mejoras en el nodo de efecto 
Colour Curve (Curvas de 
colores)

Se ha mejorado y ampliado el nodo Colour Curve (Curvas de colores) para que 
sea totalmente compatible con las escenas configuradas para renderizar 
utilizando el procesamiento de 32 bits por canal.

 l El nuevo atributo Clamp Output Values (Fijar valores de salida) se 
puede utilizar para controlar si los valores se deben fijar en los valores 
especificados en los campos Minimum (Mínimo) y Maximum (Máximo). 
Este atributo no está disponible en el procesamiento de 16 bits por 
canal.

 l El nuevo atributo Extrapolate Curve Bounds (Extrapolar límites de 
curvas) extrapolará las curvas más allá de sus primeros y últimos 
puntos. Este atributo no está disponible en el procesamiento de 16 bits 
por canal.

 l Se ha agregado un control deslizante de zoom para poder alejar la vista 
del gráfico y manipular los puntos más allá del rango 0 y 1.
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Animación

Característica Descripción

Nuevos nodos de deformador 
ponderado

Ya están disponibles cuatro nuevos nodos de deformador ponderado en 
Harmony. Estos se pueden utilizar para crear distintos tipos de sistemas de 
deformador ponderado y controlar individualmente su influencia en la 
deformación global. Se pueden utilizar varios tipos de nodos de deformador 
ponderado en el mismo sistema de deformación para obtener más flexibilidad.

Se encuentran disponibles los siguientes nodos nuevos:

 l Weighted Point (Punto ponderado): el nodo Weighted Point (Punto 
ponderado) utiliza el pivote de cada peg para crear el sistema de 
deformación. Se pueden agregar a sistemas de deformador ponderado 
existentes para aplicar distintas influencias a grupos individuales de 
pegs.

 l Weighted Curve (Curva ponderada): se utiliza para definir una curva 
que influye en el sistema de deformación. Hay tres tipos de curvas 
disponibles y se crean mediante pegs conectados al nodo.

 l Weighted Line (Línea ponderada): crea una línea recta definida por los 
pegs adjuntos. La línea resultante se utiliza para influenciar la 
deformación.

 l Weighted Drawing (Dibujo ponderado): utiliza un único dibujo como 
entrada que se utiliza para influenciar el sistema de deformación. El 
dibujo define la forma de la influencia y se puede transformar con un 
peg para deformar el sistema global.

Los nuevos nodos de deformador ponderado están disponibles en la librería de 
nodos en Deformation > Weighted (Deformación > Ponderado).

Nodo OGL Controller 
(Controlador OGL)

El nuevo nodo OGL Controller (Controlador OGL) proporciona un controlador 
seleccionable que se puede utilizar para seleccionar un dibujo o un peg en 
cualquier lugar de la escena y que de otro modo sería difícil de seleccionar. Los 
controladores OGL no se pueden ver en los renders de software, sino solo en 
OpenGL.

El nodo proporciona formas básicas que se pueden utilizar como 
representación gráfica del controlador. También se puede conectar un nodo de 
dibujo para utilizarlo como controlador de forma personalizada.

Este nuevo nodo está disponible en la librería de nodos en la categoría 
Controller (Controlador). 
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Mejoras en los pivotes de las 
herramientas Transform 
(Transformar) y Translate 
(Traslación)

Se han realizado las siguientes mejoras en la representación gráfica y en la 
manipulación de los pivotes cuando se utilizan las herramientas Translate 
(Traslación) y Transform (Transformar):

 l Una nueva preferencia denominada Use a Donut-Style pivot (Utilizar un 
pivote tipo donut) de la herramienta Transform (Transformar), situada 
en la pestaña Advanced (Avanzado) en Preferences (Preferencias), 
cambia el pivote circular de la herramienta Transform (Transformar) por 
un donut, que permite seleccionar anclajes situados bajo el pivote a 
través de su agujero central. Esta preferencia está desactivada de forma 
predeterminada.

 l Una nueva preferencia denominada Allow Temporary-Pivot dragging 
(Permitir arrastre de pivote temporal) en la vista de cámara, situada en 
la pestaña Advanced (Avanzado) en Preferences (Preferencias), 
desactiva la manipulación interactiva del pivote de la herramienta 
Transform (Transformar) cuando no está marcada. Esta preferencia está 
activada de forma predeterminada.

 l Se han agregado nuevos atajos de teclado para mover la posición del 
pivote temporal de la herramienta Transform (Transformar), así como el 
pivote de la herramienta Translate (Traslación), sin tener que hacer clic 
y arrastrarlo.

 l Move Element or Peg Pivot to Cursor (Mover pivote de 
elemento o peg al cursor): mueve el elemento seleccionado o el 
pivote del peg a la posición del ratón mientras la herramienta 
Translate (Traslación) está activa. La tecla Tab está asignada 
como el atajo de teclado predeterminado.

 l Move Temporary Pivot to Cursor (Mover pivote temporal al 
cursor): mueve el pivote temporal de la herramienta Transform 
(Transformar) a la posición actual del cursor en la vista de 
cámara. La tecla Tab está asignada como el atajo de teclado 
predeterminado.

 l Move Temporary Pivot to Default (Mover pivote temporal a 
predeterminado): restablece el pivote temporal de la 
herramienta Transform (Transformar) a su posición 
predeterminada. Atajo de teclado predeterminado: Ctrl+Tab en 
Windows y Option+Tab en macOS
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Característica Descripción

Consola de secuencias de comandos de Python y de 
comandos de Python

.El modelo de objeto de documento Python de 
Harmony proporciona una representación en Python 
de Harmony y del proyecto cargado. Esto permite la 
creación de herramientas personalizadas y tareas de 
automatización que se pueden ejecutar desde dentro 
de Harmony utilizando la nueva consola de 
comandos de Python, o externamente a Harmony 
desde un intérprete de Python.

Este módulo Python de Harmony es compatible con 
Python 3.9 o posterior. Si el módulo se importa 
desde la vista de consola de comandos de Python de 
Harmony, se requiere la versión Python 3.9.x.

La consola de comandos de Python solo estará 
disponible cuando Harmony se inicie en un entorno 
que proporcione las librerías de Python. La ruta de 
las librerías de Python se puede especificar 
mediante la preferencia PYTHON_LIB_PATH o 
dando acceso al archivo ejecutable de Python desde 
la variable del entorno de PATH.

Para obtener más información, consulte la página 
principal en la documentación de la interfaz de 
Python. Para acceder a la documentación, abra el 
archivo index.html en la carpeta Documentation 
(Documentación) de la aplicación de Harmony:

Windows:

C:\Archivos de programa (x86)\Toon Boom 
Animation\Toon Boom Harmony 22 
Premium\help\python\

macOS:

/Applications/Toon Boom Harmony 22 
Premium/Harmony 22 
Premium.app/Contents/Documentation/python/

Actualizaciones de las clases de Qt

Desde la actualización a Qt 6 de Harmony 21.1, 
algunas clases de Qt que formaban parte del 
paquete QtScriptBinding en las versiones anteriores 
de Harmony han quedado obsoletas, se han 
sustituido o no se han incluido en Harmony 21.1.

Todas las clases de Qt que faltaban ahora están 
empaquetadas con Harmony 22.
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Correcciones

General

 l La preferencia Focus on Mouse (Centrarse en ratón) no funciona cuando el ratón se mueve a una vista 
de OpenGL. HAR-8218

 l BBox de la herramienta Transform (Transformar) está en la posición incorrecta cuando se utilizan 
dibujos de mapa de bits con deformadores ponderados y de forma libre. HAR-7787

 l BBox de la herramienta Transform (Transformar) está en la posición incorrecta cuando se utiliza un 
deformador con un nodo de elemento que tenga un desplazamiento. HAR-8464

 l Bajo rendimiento al utilizar un nodo de intercambio de canal bajo una composición de transferencia. 
HAR-8340

 l El orden de composición de OpenGL es incorrecto cuando se utiliza el nodo Apply-Peg-Transformation 
(Aplicar transformación de peg) dentro de una escena 3D. HAR-8518

 l Faltan los colores de los vértices de los archivos de Alembic. HAR-8304

 l La preferencia Element Node “Animate Using Animation Tools” Default Value (Valor predeterminado 
del nodo de elemento “Animar con herramientas de animación”) se ignora cuando se importa un archivo 
PSD de varias capas. HAR-6845

 l Los valores altos de espaciado del discretizador pueden hacer que el creador de distorsión de 
envolvente se bloquee. HAR-7396

 l No se suavizan las líneas de contornos durante la reproducción. HAR-8262

 l A veces, Harmony se bloquea al abrir una segundo escena si el caché de nodo está activo. HAR-8348

 l Al desconectar un cable de un nodo de deformador ponderado, a veces se desconecta el cable 
incorrecto. HAR-8535

 l La aplicación Scan se bloquea al intentar importar una imagen mediante el comando Load From File 
(Cargar desde archivo). HAR-8350

 l H.264/MP4 no está disponible como formato de exportación cuando se ejecuta Harmony en un sistema 
Apple Silicon. HAR-8188

Drawing (Dibujo)

 l Las miniaturas no se actualizan correctamente en la vista de sustituciones de dibujo. HAR-7493

 l Las opciones Draw Stroke as Straight Lines (Dibujar trazo como líneas rectas) y Connect Line Ends 
(Conectar extremos de línea) de la herramienta Stroke (Línea vectorial transparente) no funcionan. 
HAR-8416

 l Los vectores no se desplazan al pegarlos varias veces en otra capa de dibujo. HAR-8436
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 l La vista de dibujo no se actualiza inmediatamente cuando se cambian las opciones de desplazar y trazar 
del escritorio de dibujo. HAR-8487

 l Hay pequeños huecos en las uniones de colores después de utilizar el pincel de patrón en el modo de 
repintado. HAR-8417

Vista de referencia

 l Las capas no se pueden arrastrar desde la línea de tiempo a la vista de referencia (modelo). HAR-8323

 l Arrastrar y soltar una plantilla desde la librería hasta la vista de referencia (modelo) no funciona. HAR-
8547

 l La vista de referencia utiliza la tecla Suprimir en lugar de la tecla Retroceso para descargar los dibujos. 
HAR-8539

Renderizado

 l La opción Turbulent Noise (Ruido turbulento) se desplaza cuando se agrega un efecto de desenfoque a 
continuación. HAR-7789

 l Las imágenes EXR del nodo Multi Layer Write (Escritura multicapa) tienen varios fotogramas apilados 
uno encima de otro. HAR-8228

 l El atributo Alignment Rule (Regla de alineación) no funciona en los renders de software con algunos 
archivos JPEG. HAR-7335

Controladores maestros

 l Se deja de analizar el estado de rig del Controlador maestro cuando se alcanza un valor pequeño o alto. 
HAR-8412

 l La adición o eliminación de filas y columnas no funciona desde el Asistente de cuadrícula del 
Controlador maestro. HAR-8564

Secuencias de comandos

 l El comando SCR_DrawingKey siempre devuelve el resultado nulo cuando se proporciona una clave de 
dibujo en las secuencias de comandos. HAR-8407

 l La interfaz de secuencias de comandos del Centro de control siempre renderiza la cámara 
“predeterminada” si no se especifica ninguna cámara. HAR-8403

 l El comando QByteArray no se puede construir con una cadena como argumento de construcción. HAR-
8497

 l Los botones más (+) y menos (-) son invisibles en TB_ExportToEaselJS, TB_ExportToSpriteSheets y 
TB_SelectionPreset. HAR-8500
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Base de datos

 l Link Server no funciona en Linux si no hay un servidor con un sistema de ventanas X. HAR-8563

 l Se puede bloquear la carpeta raíz, pero esto impide el bloqueo de cualquier otra carpeta de la base de 
datos. HAR-8556

 l Las paletas se bloquean al renderizar escenas por lotes si se recuperan los colores. HAR-8536

 l La importación de escenas en el modo por lotes bloquea el Centro de control si la escena ya existe. 
HAR-8503

Problemas conocidos
 l Cuando no hay suficiente espacio para todos los botones de una barra de herramientas, la extensión 

que se puede abrir para acceder a los botones se oculta cuando se abre sobre una vista de OpenGL. 
HAR-8186

 l Los gestos táctiles para hacer zoom, panear y rotar no funcionan en Windows. HAR-8739

 l Cuando se utiliza Harmony en Big Sur, Harmony se puede bloquear al guardar un color en el selector de 
color nativo de macOS. HAR-8032

 l Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del 
Centro de control. HAR-6386

 l El trazo permanece en su lugar después de eliminar el último punto de una rama con la herramienta 
Centerline Editor (Editor de línea central). HAR-5994

 l En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de 
cuarentena del paquete de aplicaciones. El atributo extendido de cuarentena se puede eliminar 
mediante el siguiente comando en el terminal: 

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 
21.1 Premium"
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